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Abstract: This document introduces users to more advanced PowerPoint 

tasks, such as creating hyperlinks to other slides, presentations, 

files, and Web sites; inserting action buttons and charts into 

presentations, animating text and graphic objects; adding slide 

transitions, and so on. It is used in conjunction with the 

PowerPoint Intermediate workshop. 
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Introduction 

PowerPoint is a presentation graphics package, a program that creates slide show 

presentations. This workshop introduces some of the advanced features of the program. 

Participants learn about Action settings and buttons, animating text and graphics, 

inserting pictures, tables and charts, and preparing a presentation for the Web. 

Objectives 

The goal of this workshop is to introduce participants to the advanced commands and 

features of PowerPoint. After today's workshop, participants will be able to: 

Create an action button. 

Insert a graphic, table and chart. 

Animate text and graphics. 

Prepare slide transitions and timings. 

Prepare a presentation for the Web. 

Prerequisites 

PowerPoint: Introduction or equivalent skills. 

Action Settings 

Action settings allow you to jump to a specified place in your presentation at the click of 

the mouse, rather than presenting your slides in linear sequence. They also allow you to 

jump to another presentation or program, or a Web site on the Internet. Actions can be 

associated with any object on a slide, including text, tables, or graphics. Associating an 

action with an object is known as creating a hyperlink. 

Note: To test an action setting (for example, a hyperlink or button), you must 

change to the Slide Show view. 

Create a hyperlink 

You can use Action Settings to create a hyperlink from any object on your slide, i.e., a 

graphic, text, drawing, or line. 

Caution: If you hyperlink to a web page or other resource on the Internet, you 

will need an Internet connection when you give your presentation. 

To create a hyperlink with slide text or a slide object: 

Save your presentation.  

Select the text or object you want to represent the hyperlink.  

Click the Slide Show menu and select Action Settings….  The Action Settings dialog 

box appears. 
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Click either the Mouse Click tab or the Mouse Over tab, depending on whether you 

want to perform this action when you click the mouse button on the object, or when 

you roll the mouse over the object. 

Click the Hyperlink to: radio button, then choose URL… from the drop-down list, as 

shown below: 

 

Choosing to hyperlink to a URL in the Action Settings dialog box. 

Type in the URL to the file, web page or resource, as shown below. If you are linking to a 

Web page, be sure to include the complete URL, including the scheme (usually 

http://). If you aren’t sure which scheme to use, visit the page in a web browser, and 

copy the URL as it appears in the address line of the web browser window. 

 

Click OK, and OK again to create the hyperlink. 

To test your work, switch to the Slide Show view and click the hyperlink. 

Note: Before you give a presentation, you should always check for 

broken hyperlinks and test hyperlinks to external destinations. A 

broken hyperlink is one that has an invalid destination — when the 
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hyperlink is clicked, PowerPoint or the Web browser displays an error. 

The cause might be as simple as a URL that was mistyped, or a 

hyperlink to a destination that was moved or deleted. 

You can create hyperlinks that are absolute links or relative links. 

When you create a presentation with links to several files, it is a good 

practice to put the files in a common location on a server and set a 

hyperlink base. If the server URL changes, you only have to update the 

hyperlink base, not the paths to the hyperlink destinations. 

Action buttons 

Action buttons are a special set of graphics available in PowerPoint that have pre-

assigned actions associated with them. For example, the right-arrow button  is preset 

to cause the next slide to be displayed when that button is clicked. Action buttons can be 

inserted on any slide and can be edited to change the appearance or the pre-assigned 

action. 

Create an Action button 

To create an action button: 

1. Display the slide on which you want to place an action button. 

2. Click the Slide Show menu and point at Action Buttons.  From the submenu, select 

a button type you want to use, as shown: 

 

Selecting an Action button type. 

3. The mouse pointer displays as a crosshairs ( ). Holding down the left mouse 

button, draw a rectangle the approximate size of the button you want to display on 

the slide. 
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4. The Action settings dialog box displays a default hyperlink setting (unless you chose 

the custom, or blank, button type). The hyperlink action is performed when you click 

the button during the slide show presentation. If you want the action to perform 

when you roll the mouse over the button, click the Mouse Over tab before confirming 

or changing your actions. 

5. If this is not the action that you would like performed when you click the button, 

select a new action from the pull-down menu, and/or select from the other options to 

run a program or play a sound. 

6. Click OK. 

Tips: • You can also access the Action settings dialog box if you click the 

right mouse button on the object you want to represent the 

hyperlink to display a pop-up menu. Select Action settings. 

• If you set up a hyperlink to advance to a different slide in the 

presentation, you may also want to add a hyperlink on the slide 

you advanced to, to return you back to the original one. 

Link examples 

Here are some examples of links: 

The path can be an Internet URL: http://www.ku.edu 

The path can be a folder on a hard drive: c:\projects 

The path can be a path to a folder on a local area network: \\cc_labs\folder one\subfolder 

Editing the hyperlink and buttons 

You can edit or change the destination of a hyperlink or you can change the object that 

represents a hyperlink without losing the link.  

To edit a hyperlink: 

1. Click your right mouse button on the hyperlink button, graphic or text. 

2. Select Action settings. 

3. Change the hyperlink action and click OK. 

4. If you want to edit a URL, you need to select URL… from the list of hyperlink 

action options and then edit the text. 
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Notes: Action settings and buttons are active only when you run your slide 

show, not when you're creating or editing the slides.  

You can also quickly set up hyperlinks by clicking Insert Hyperlink 

( ) on the Standard toolbar. (This button is also used in Word, 

Excel, and Access.) 

To add text to or edit text on an action button, right-click the action 

button and select Add Text or Edit Text.  

To resize the graphic image on an action button (without resizing the 

button itself), 

1. Click on the button to select it. 

 

2. Drag the yellow diamond (located above the left corner of 

a selected button) to the right to decrease the image size 

within the button dimensions. Drag the yellow diamond to 

the left to increase the image size. 

Insert a table 

To insert a table in the PowerPoint slide: 

1. Click on the Insert menu and select Table….  The Insert Table dialog box appears. 

2. Type in the number of rows and columns needed. 

3. Click OK.  A table appears on the slide.  This can be resized as needed.  Start typing 

the information into your table. 

4. To change the formatting of a table, use the Tables and Borders toolbar, which 

appears when you have a table selected (or you can click the View menu, choose 

Toolbars, and choose Tables and Borders to display the menu). With this toolbar you 

can modify the borders, fill colors, alignment within the cell, and more. 

 

Insert a chart or an external document/file 

Importing data for a chart 

To import data from another spreadsheet program: 

1. Click the Insert menu and select Chart…. 

2. Select the datasheet attached to the displayed chart. 
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3. If you are importing a Microsoft Excel worksheet and you want the imported data to 

begin at a cell other than the upper-left cell on the datasheet, select the cell. 

4. On the Edit menu, click Import File….  The Import File dialog box appears. 

5. In the Look in: box, browse to the file, select it, and click Open. The Import Data 

Options window (shown below) is displayed. 

 To import all the data on the worksheet, click Entire sheet under the 
Import section.  

 To import only part of the data, click Range:, and then type the range of 

data you want. For example, to import cells A1 through C7, type A1:C7 in 
the Range box.  

 

 If you want to replace the existing data in the chart’s datasheet with the 

data in this spreadsheet, check the Overwrite existing cells check box. 
If you want to keep the existing data in the chart’s datasheet, uncheck this 

box. 

6. Click OK.  

Import notes 

• To open a file saved in a format other than Excel (such as a comma- or tab-delimited 

text file), click the file format you want in the Files of type box when importing the 

data. 

• Importing data into a datasheet is probably the easiest way to create a chart from pre-

existing data. 

Inserting existing documents 

You can insert information from files created with other programs such as Word, Excel, 

and PageMaker into your PowerPoint presentation in one of two ways: by linking to the 

information, or by embedding the information within your presentation. 
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Linking to existing files 

When you link to an existing file, the information remains stored in the source file. 

PowerPoint displays a representation of the linked information but stores only the 

location of the original data, not the information itself. The linked information is 

updated automatically if you change the original data in the source file. Use linked 

objects if you want the information to reflect any changes to the original data or if file 

size is a consideration. 

If you link a file to your presentation you will need access to that linked file when you 

give your presentation. One way to do this is by using the Pack and Go feature, and 

choosing to include linked files. 

Embedding existing files 

An embedded object becomes an actual part of the PowerPoint presentation. Even though 

you may not have access to the original file at the time you conduct your presentation, 

you can open the version of the file that is embedded in your presentation. Because an 

embedded object has no links to the source file, it is not updated if you change the 

original data in the source file.  

To change an embedded object, double-click the object to open and edit it in the source 

program (the program with which the file was originally created). The source program (or 

another program capable of editing the object) must be installed on your computer. If you 

include a file as an embedded object, the PowerPoint presentation requires more disk 

space than if you link the file. 

Insert an existing file 

1. To insert an existing file, select the slide into which you want to insert the object.  

2. On the Insert menu, click Object….  The Insert Object dialog box appears. 

3. Click the Create from file radio button. This means create (a connection) from an 

existing file. 
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4. In the File: field, type the location and name of the file or click Browse… to select 

the file name from a location. 

 

To create a link to the file (updated every time the PowerPoint presentation is edited), 

select the Link check box. The object (file) is embedded if you don't select the Link 

check box. 

To display the linked or embedded object as an icon of the software that was used to 

create it (rather than displaying the file itself), select the Display as icon check box. 

Note: When you create an embedded object from an existing Excel 

workbook, the entire workbook is inserted into your presentation. 

Since only one worksheet displays at a time, double-click the object to 

select a different worksheet. 

Animation 

You can animate text, graphics, sounds, movies, and other objects on your slides to add 

special visual or sound effects to text or objects on your slides. You can also animate 

elements of a chart. 

For example, on a slide with several bulleted items, you can display one item at a time 

after you click the mouse. You can have the text appear by topic and with or without all 

subtopics, or you can have text appear a word or a letter at a time. 

Animate Entire Slides and Presentations 

If you want to animate all of the objects on a slide, or if you want to apply a style of 

animation to your entire presentation, use the Animation Schemes feature. 

To animate an entire presentation: 

1. Click the Slide Show menu and select Animation Schemes….  The task pane 

changes to show the Slide Design options. 

2. In the task pane on the right, browse through the animation categories, Subtle, 

Moderate, and Exciting.  
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3. To apply a scheme to the current slide, click it.  

Note: There is no “preview” feature for Animation Schemes; if you decide 

not to use the scheme you’ve selected, or want to remove animation 

from the current slide, click No Animation from the list of choices. 

4. To apply the animation scheme to your entire presentation, click Apply to All Slides. 

Animate a single object on a slide 

To animate a single text box or object: 

1. In Normal View, display the slide that has the text or objects you want to animate. 

2. On the Slide Show menu, click Custom animation….  The task pane changes to 

show the Custom Animation options. 

3. On the slide, click the object you want to animate to select it. 

4. On the task pane to the right, click the Add Effect button, and choose the effect you 

want, as shown: 
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5. If needed, change the basic settings for the animation effect, such as the direction and 

speed of the animation, in the task pane. To access and change more detailed 

animation settings, click the numbered animation item in the task pane, then click the 

drop-down menu (as shown below), select the option you want to modify, and make 

any desired changes. 

 

Repeat steps 3 through 6 for every object you want to animate. 

Change the display order of animated objects 

To change the display order of custom-animated objects on a slide: 

1. Display the slide on which you want to change the order of animation. 

2. On the Slide Show menu, click Custom Animation….  The task pane changes to 

show the Custom Animation options. 

3. The order in which objects on the slide will be 

animated is shown in the Custom Animation task 

pane on the right. To change the order, click the 

object you want to change, and then click either 

the up or down “Re-Order” arrows (shown at 

right) at the bottom of the pane to reposition the 

slide object within the list. 

Repeat the process for each object whose order you want to change. 
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Slide Show Enhancements 

Several other enhancements are available in PowerPoint to help you create slide shows, 

including slide transitions, timing your presentation, and creating custom slide shows. 

Transitions 

A transition is a special effect used to introduce a 

slide. A transition can include a sound as well as 

animation, and display on a mouse click or after a 

preset time. To apply a transition to a slide: 

1. In the Normal or slide sorter view, select the 

slide(s) to which you want to add a transition. 

2. Click the Slide Show menu and select Slide 

Transition….  The task pane changes to show the 

Slide Transition options. 

3. In the task pane on the right, select the transition 

you want. The transition effect will be previewed 

on the current slide. 

4. Also in the task pane, if necessary, change the 

speed of the transition and/or add a sound to it. 

5. If you want the transition to occur automatically, 

based on a set timing (rather than occurring when 

you click the mouse or press a button), under 

Advance slide, check Automatically after and set 

a time (in minutes and seconds). 

6. If you want to apply the same transition (with the 

settings you’ve selected) to all the slides in the 

presentation, click the Apply to All Slides button 

(as shown at right). 

Timings 

The slide meter allows you to rehearse your slide show 

so that you present within a set amount of time or you 

can set the slide meter to advance your slides 

automatically during the presentation. 

If you don't want to manually move through a slide show, there are two ways you can set 

the length of time a slide appears on the screen. One way is to set a time manually for 

each slide, and then run the slide show and view the timings you set. The other way is to 

use the rehearsal feature, where you can record timings automatically as you rehearse. 

You can also adjust the timings you've already set and then rehearse the new ones. 
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Set timings manually 

To set slide show timings manually: 

1. In the normal or slide sorter view, select the slide(s) for which you want to set the 

timing. 

2. Use the automatic settings within the Slide Transition task pane (show this pane by 

clicking the Slide Show menu, then Slide Transition…) to enter the number of 

seconds you want the slide to appear on the screen. 

3. To apply the timing to all the slides, click the Apply to All Slides button. 

To test the timings, select View Show from the Slide Show menu. 

Set timings while rehearsing 

To set slide timings while rehearsing: 

1. Click the Slide Show menu, and then click Rehearse Timings.  The slide show view 

begins with the Rehearsal dialog box visible. The white box on the left shows the 

time elapsed for the current slide. The blue box at the right shows the total elapsed 

time for the whole slide show. 

 

2. Click the advance button (the right-pointing arrow) when you're ready to go to the 

next slide or the next animation. 

3. When you reach the end of the slide show, a message box appears asking if you 

“want to keep the slide timings to use when you view the slide show.” Click Yes to 

accept the timings or No to try again.  

4. If you know the timing you want for a slide, you can type it directly in the Rehearsal 

dialog box. 

Custom Shows 

The Custom Show feature allows you to create another slide show from a subset of slides 

within the active slide show. This feature is useful if you want to create a shorter version 

of a slide presentation, or if you want to create several versions of the same basic 

presentation. 

Create a custom show 

To create a custom slide show: 

1. Click the Slide Show menu and select Custom Shows….  The Custom Shows dialog 

box appears. 
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2. Click the New… button.  

 

3. Enter a name for the custom show in the Slide show name: text box. 

4. Select a slide title from the left window and click the Add button or double-click the 

slide title to add that slide into the new custom show. Repeat this process to add each 

slide you want to appear in the custom show. 

5. Use the up and down arrows to the right of the Slide in custom show window to 

reposition the slides within the show. You can also use the Remove button to delete 

slides from the Slides in custom show: window.  

6. Click OK to create the custom show. 

7. Click Close. 

Run a custom show 

To run a previously created custom show: 

1. Select Custom Shows from the Slide Show menu. 

2. Select the custom show you want to run from the menu. 

3. Click the Show button.  The slide show view starts with all animation the same. 

Edit a custom show 

To edit a previously created custom show: 

1. Select Custom Shows… from the Slide Show menu. 

2. Select the custom show you want to edit from the menu. 

3. Click the Edit… button. 

4. Reorder or remove slides from the custom show as needed. 

5. Click OK to accept the changes you’ve made. 

6. Click Close. 
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Save as Web page 

Note: Although the feature is called “Save as Web Page,” it actually creates 

many files within a presentation folder, including HTML files and 

image files. In order to make the presentation available on the World 

Wide Web, all the files created in this process need to be transferred to 

a Web server and given appropriate file permissions. 

For more information on publishing files to the Web, see the Web 

Authoring: HTML Introduction workshop (to check availability or 

download the handout in PDF format, visit 

www.lib.ku.edu/instruction/workshops). 

You can create a set of web files from your slide show presentation, which you can 

publish to the World Wide Web. To do this, 

1. On the File menu, choose Save as Web Page….  The Save As dialog box appears. 

 

2. Choose the location where you want to save your web files. 

3. Name your file and click the Change Title… button to change the title bar of the 

browser. If you are planning on publishing this presentation on the web, do not 

put spaces in the file name; instead, use dashes or underscores (for example, use 

“my_presentation.htm” or “my-presentation.htm” rather than “my 

presentation.htm”). Click OK. 
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4. Click on the Publish… button. The Publish as Web Page dialog box displays: 

 

5. Under the Publish what? section, select which slides to publish and whether to 

publish speaker notes. 
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6. If you want to change the web settings, click on the Web Options… button. This will 

allow you to change the setup or appearance of the web version of the presentation, 

such as the appearance of the navigation controls, the fonts, and so on. Click OK to 

return to the Publish as Web page dialog box. 

 

7. The General tab allows you to choose whether slide animation will be included in 

the Web version. 

8. Set other options as needed and click OK. 

9. Click the Publish button to create the web files. 

Now you’re ready to view your web page.  
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Web Page Preview 

To get an idea of how your presentation will look when it is saved as a set of web pages, 

click the File menu and choose Web Page Preview. A temporary version of the web 

page set will be displayed in your web browser, as shown: 

 

View the Saved Web Version 

Once the process is completed, the Web version of your presentation is stored in the 

location you specified. You can view this version with any Web browser (such as 

Navigator or Internet Explorer).  

In order to make the presentation available on the World Wide Web, all the files created 

in this process need to be transferred to a Web server and given appropriate file 

permissions. 

For More Information 

Here are some additional sources of information about Microsoft PowerPoint: 

Microsoft Support searchable page (http://support.microsoft.com) – this site has a 

search form in which you can enter the product and version you are using (PowerPoint 

2000 or XP, for example) and type in keywords or phrases to find technical articles that 

answer your questions. 

PowerPoint Product Support (http://office.microsoft.com/powerpoint) - view 

frequently asked questions, how-to articles, and other support documents for your version 

of PowerPoint. 
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Getting Additional Help 

The Help Desk provides consulting and Q&A help in a variety of ways: 

785/864-0200 

question@ku.edu 

www.ku.edu/~helpdesk 

Last Update: 01/30/2006 


